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Introduction 

This Administrator’s Guide is divided into four sections: 

Installation of Spectrum ES – the step-by-step procedure for installing the software. 

Administration of Spectrum ES – details of the role of an Administrator (Windows 
Administrator and Software Administrator), login types and using the Admin Utility to create 
users and assign them to groups. 

Overview of Spectrum ES – an introduction to the software and details of the on-screen 
HTML Help system. 

Appendices – there are six appendices that describe the following: (i) configuring TCP/IP 
communication, (ii) using the Windows Configuration Script to add increased security to your 
Windows system, (iii) backing up and recovering database files and recovering from 
Checksum failures, (iv) using the Legacy File Converter to convert old spectra, (v) an 
introduction to the Quant Import Utility, and (vi) the link between Windows logon security, 
NTFS Permissions and Spectrum ES security. 

Further Information 

For more detailed information on using Spectrum ES software, access the HTML Help files by 
selecting the Contents and Index command from the Help menu. Further information on 
getting the most from the HTML Help system is given in HTML Help on page 60. 

For more information on your Spectrum One, Spectrum One NTS or Spectrum GX instrument 
consult the manuals that come with the instrument. Multimedia tutorials may also provide 
further information and are available for the Spectrum One and Spectrum One NTS 
instruments. 
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Conventions Used in this Manual 

Normal text is used to provide information and instructions. 

Bold text refers to text that is displayed on the screen. 

UPPERCASE text, for example ENTER or ALT, refers to keys on the PC keyboard. '+' is used 
to show that you have to press two keys at the same time, for example, ALT+F. 

All eight digit numbers are PerkinElmer part numbers unless stated otherwise. 

Notes, cautions and warnings 

Three terms, in the following standard formats, are also used to highlight special 
circumstances and warnings. 

NOTE: A note indicates additional, significant information that is provided with some 
procedures.
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CAUTION 
 

 
We use the term CAUTION to inform you about situations that could 
result in serious damage to the instrument or other equipment. Details 
about these circumstances are in a box like this one. 
 

D Caution (Achtung) 
Bedeutet, daß die genannte Anleitung genau befolgt werden muß, um 
einen Geräteschaden zu vermeiden. 

DK Caution (Bemærk) 
Dette betyder, at den nævnte vejledning skal overholdes nøje for at 
undgå en beskadigelse af apparatet. 

E Caution (Advertencia) 
Utilizamos el término CAUTION (ADVERTENCIA) para advertir sobre 
situaciones que pueden provocar averías graves en este equipo o en 
otros. En recuadros éste se proporciona información sobre este tipo de 
circunstancias. 

F Caution (Attention) 
Nous utilisons le terme CAUTION (ATTENTION) pour signaler les 
situations susceptibles de provoquer de graves détériorations de 
l'instrument ou d'autre matériel. Les détails sur ces circonstances 
figurent dans un encadré semblable à celui-ci. 

I Caution (Attenzione) 
Con il termine CAUTION (ATTENZIONE) vengono segnalate situazioni 
che potrebbero arrecare gravi danni allo strumento o ad altra 
apparecchiatura. Troverete informazioni su tali circostanze in un 
riquadro come questo. 

NL Caution (Opgelet) 
Betekent dat de genoemde handleiding nauwkeurig moet worden 
opgevolgd, om beschadiging van het instrument te voorkomen. 

P Caution (Atenção) 
Significa que a instrução referida tem de ser respeitada para evitar a 
danificação do aparelho. 
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WARNING 

 
We use the term WARNING to inform you about situations that could 
result in personal injury to yourself or other persons. Details about 
these circumstances are in a box like this one. 
 

D Warning (Warnung) 
Bedeutet, daß es bei Nichtbeachten der genannten Anweisung zu einer 
Verletzung des Benutzers kommen kann. 

DK Warning (Advarsel) 
Betyder, at brugeren kan blive kvæstet, hvis anvisningen ikke 
overholdes. 

E Warning (Peligro) 
Utilizamos el término WARNING (PELIGRO) para informarle sobre 
situaciones que pueden provocar daños personales a usted o a otras 
personas. En los recuadros como éste se proporciona información 
sobre este tipo de circunstancias. 

F Warning (Danger) 
Nous utilisons la formule WARNING (DANGER) pour avertir des 
situations pouvant occasionner des dommages corporels à l'utilisateur 
ou à d'autres personnes. Les détails sur ces circonstances sont 
données dans un encadré semblable à celui-ci. 

I Warning (Pericolo) 
Con il termine WARNING (PERICOLO) vengono segnalate situazioni 
che potrebbero provocare incidenti alle persone. Troverete 
informazioni su tali circostanze in un riquadro come questo. 

NL Warning (Waarschuwing) 
Betekent dat, wanneer de genoemde aanwijzing niet in acht wordt 
genomen, dit kan leiden tot verwondingen van de gebruiker. 

P Warning (Aviso) 
Significa que a não observância da instrução referida poderá causar 
um ferimento ao usuário. 
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Init ial Requirements 

The following pages provide details of the requirements for the PC that will run the  
Spectrum ES software and communicate with the instrument. To ensure successful 
installation of the software, please check these requirements before starting the installation. 

W indows Administrator Level 

It is important to note that you must be logged on at Administrator level on Windows before 
installing the software. Logging on as an Administrator ensures that installation of the 
software can be undertaken and that the necessary system registry updates that form part of 
the installation process are successfully completed. Administrators have the capability to 
assign privileges and logon rights and therefore have the ability to make system wide 
changes. Users on the other hand do not have this ability, or may have restricted abilities 
depending on the rights and privileges assigned by the Administrator. 

TCP/ IP Communication 

To operate a Spectrum One or Spectrum One NTS you will need TCP/IP protocols established 
on the PC (see Appendix I – Configuring TCP/IP Communication on page 68). We 
recommend that you do not install Spectrum ES Software until this has been set up. 

NOTE: TCP/IP addresses are not relevant for the Spectrum GX. 

Previous versions of IR Software 

Spectrum ES Software has a security system that is incompatible with previous versions of IR 
software (including Spectrum and Spectrum CFR) and cannot be installed on a PC with other 
IR software from PerkinElmer. We recommend you purchase a new PC to run the software. If 
you are using an existing PC we recommend that you format the hard disk on the PC (after 
backing up any important data). After formatting, install the Windows operating system 
before installing the Spectrum ES Software. 

Indeo software codecs 

Indeo software codecs are used to run the multimedia tutorials that are on the Spectrum One 
Multimedia CD and Spectrum One NTS Multimedia CD. The installation for this will run 
automatically during the software installation and we suggest you use the default options 
when installing this software. 
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NOTE: If you want to run the multimedia tutorials on a PC without installing Spectrum ES 
software on it, the installation routine is also in the Extras folder on the multimedia 
CD and is called iv5play.exe. 

SIMCA Procedures 

SIMCA procedures are shipped on the CD in a separate folder called /SIMCA. These 
procedures can be copied into a folder on the hard disk directly from the CD itself. The 
procedures may then be added into the software using the Admin utility. 

NOTE: Although these SIMCA procedures are supplied in case you require them, it is 
important to note that these are not 21 CFR Part 11 compliant. If you need to 
develop these further then you can purchase Spectrum Procedures from PerkinElmer 
or alternatively the AssureID ES software already has 21 CFR Part 11 technically 
compliant SIMCA built in. 
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Installing The Driver For The Spectrum GX 

After the PerkinElmer Service Engineer has installed the Single PCI Transputer Card in the 
computer, the driver software for the card needs to be installed. 

NOTE: Both hardware and software installation of the card must be performed before 
installation of the IR Spectroscopy Software for a Spectrum GX system. 

NOTE: By default the GX installation installs the drivers for a card with a single transputer on 
board. If you have a multitransputer card, you need to copy the file 
\pel_apps\gx2000\s2k1.5 to \pel_apps\bin\s2k1.in. Should you need to switch back 
to a single transputer card, copy the file \pel_apps\gx2000\s2k1.1 to 
\pel_apps\bin\s2k1.in 

Driver Installation under Windows 2000 

1. When the computer is turned on, Windows 2000 usually automatically detects that a 
new hardware component has been installed. As a result the New Hardware Wizard is 
automatically loaded. 

NOTE: If the auto detect feature fails to activate, that is, the first screen of the wizard does 
not display on start up, then the driver needs to be installed manually. This is covered 
in Manual Installation of the Driver on page 15. 
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2. Click Next to proceed with the installation of the driver. 
 

 

 

 

 

 

 

 

 

3. Within the second screen of the wizard, select Search for a suitable driver for my 
device (recommended) and then click Next to continue. 
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4. Ensure that the CD-ROM drives option is selected. 
Ensure that the IR Spectroscopy Software CD is in the CD drive and then click Next. 

 

NOTE: The location of the drive as specified in the above screenshot may not be the same 
during installation. 

5. After the system has successfully located the driver click Next. 
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6. When installation of the driver is complete click Finish to exit the wizard. 

7. If a message is displayed, indicating that the computer needs to be restarted before the 
driver may be used, then click Restart. 

Manual Installation of the Driver 

This is undertaken if the system auto detect facility fails to automatically detect the 
installation of the Single PCI Transputer Card. 

NOTE: Ensure that the IR Spectroscopy Software CD is in the CD drive. 

1. From the Start menu, select Settings followed by Control Panel. 

2. Within the Control Panel, double-click the System icon. 
The System Properties dialog is displayed. 

3. Select the Hardware tab. 

4. Select Device Manager. 

5. Double-click the Other devices icon.  
The driver properties dialog is displayed as a result. 

6. From the list of devices double click  

7. Click Reinstall Driver. 
The driver installation wizard is displayed. 

8. Proceed with the wizard from step 1 as described previously on page 12. 
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Driver Installation under Windows XP 

NOTE: Ensure that the IR Spectroscopy Software CD is in the CD drive before commencing 
with the installation. 

 On switching on the computer and once Windows has loaded, if the Found New 
Hardware wizard is displayed, select Install the software automatically 
(Recommended) and proceed with the wizard as outlined for installing a driver under 
Windows 2000 as described under Driver Installation under Windows 2000 on page 12. 

 
 

NOTE: In Windows XP certain enhancements have been made to the wizard, and therefore 
certain steps are now integrated. For example, the wizard step concerned with 
locating driver files, is no longer present, as Windows XP automatically proceeds to 
the CD-ROM drive when installing drivers. 

If the Found New Hardware Wizard is not displayed, then continue with this section on page 
17 where manual installation of the driver is covered. 
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Manual Installation of the Driver  

1. From the Start menu, select Control Panel. 
The Control Panel dialog is displayed. 

2. Select Performance and Maintenance. 
The Performance and Maintenance dialog is displayed. 

3. Select System. 
The System Properties dialog is displayed. 

4. From this dialog, select the Hardware Tab. 

5. Click Device Manager. 
The Device Manager dialog is displayed. 

 

6. From the list double-click the Other devices icon.  
This will expose the Other PCI Bridge Device, as illustrated above. 
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7. Double-click Other PCI Bridge Device. 
As a result the Other PCI Bridge Device Properties dialog is displayed. 

 

8. Click Reinstall Driver. 
A driver installation wizard is displayed. 

9. Complete the wizard, in a similar manner as described under Driver Installation under 
Windows 2000 on page 12. 
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Installing Spectrum ES Software on Windows 2000 
or Windows XP 

NOTE: We strongly suggest you read the Initial Requirements starting on page 10, before 
attempting to install your software. 

 

NOTE: Before installing the software, we recommend that you read and print the release 
notes which can be found as a rtf file and a pdf file on the root of the IR 
Spectroscopy ES Software CD, because they contain important information that may 
not be in this Administrator's Guide or the on-screen Help. 

 

NOTE: To read .pdf files you will need Adobe Reader 5.0 or later. An installation of this 
software is available on the Software Utilities CD.  

 

NOTE: It is important to note that you must be logged on at Administrator level on Windows 
before installing the software. 

The IR Spectroscopy ES Software CD contains an Installation Wizard to help you install the 
correct software on your PC. 

NOTE: The screen shots that follow are from Windows XP, but are very similar to those in 
Windows 2000. 

1. Place your IR Spectroscopy ES Software CD into your CD drive. 

2. From the Start Menu select Run. 
The Run dialog is displayed. 
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3. Enter d:\Setup.exe and then click OK. 
Replace d:\ with the drive letter for your CD. 
After the start-up picture, the Wizard is set up and the Welcome dialog is displayed. 

 

4. Ensure that your PC meets the hardware and the software requirements as stated on 
screen as well as those given in Initial Requirements, starting on page 10, before 
clicking Next. 
If your PC does not meet any of the requirements you will be informed of the problem 
after entering the license number (step 7 below) and will need to correct it before the 
installation can be performed, otherwise the License agreement will be displayed. 
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5. Read the license and if you accept the terms, select that option and then click Next. 
You will then be asked to enter the Licence Number and Serial Number of the 
software as found on the Software Licence Certificate. 

 

 



22 . Spectrum ES Administrator’s Guide 

6. Enter the software licence number and serial number printed on the certificate provided 
and click Next. 
You now need to select the instrument type to be used.  

 

7. Select the instrument type you require (Spectrum One, Spectrum One NTS, 
Spectrum GX or Spectrum GX Raman) from the drop-down list and click Next. 

NOTE: If you will be using the software just to look at data or only to process spectra from 
disk, select No Instrument Control. 

You will now select the drive where the software is to be installed. 
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8. Select the required drive and then click Next. 

NOTE: The drive you select must be an NTFS drive, so only drives of this type will be 
available in the list. 

You will now be asked to confirm these selections. 

 

9. Check that the details are correct and then click Install. 
The installation begins. 
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If your PC does not have the indeo software codecs (see page 10) these will be installed 
as described in the following pages. If your PC already has the required software, this 
stage will be skipped and the installation will commence from step 15. 

 

10. Click Next. 
The License Agreement is displayed. 
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11. Read the agreement and click Finish. 
The software will check to see what needs to be installed and will then display a list of 
components. 

 

12. Click OK. 
A second list may be displayed, click OK again. 
The installation will begin. When it is complete, a dialog will be displayed. 

 

13. Do not read the release notes at this stage, click No. 
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14. The software will now be installed. 
When complete this will be followed by the installation of the selected instrument, as 
described in the instrument manual. 

NOTE: The screenshot that follows shows installation for a Spectrum One Instrument. If you 
are installing the software for another instrument then the relevant screen for that 
instrument will be displayed. Details of the Spectrum One and Spectrum One NTS 
installation programs are given in the User’s Guides for those instruments. 
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15. On completion, you must reboot your PC. 

16. Run the Lockdown script as detailed in Appendix II – Windows Configuration Script on 
page 76 to set further security that is required to make sure that data files cannot be 
deleted or tampered with. 

Logins 

Access control in Spectrum ES is facilitated by the Administration Utility, started by selecting 
Admin from the Spectrum ES group under PerkinElmer Applications from the Programs 
section of the Start menu. You must set up the Spectrum logins before giving access to any 
users. 

The default login to the Administration utility is administrator with the password 
administrator. You are forced to change the password immediately. 
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Introduction  

There are two main security systems used by the software: 

• Windows login security system, which manages access to the PC, its peripherals, the 
data and files on the hard disk and all aspects of the PC configuration. 

• The Spectrum ES software login security, which manages access to the software, the 
data and any associated instruments. 

These security features give maximum flexibility, allowing the customer to very tightly restrict 
what a day-to-day user is able to do and to easily fit with the company procedures designed 
to adhere to 21 CFR Part 11 compliance. 

Day-to-day usage of the system will be by Users, who are not typically allowed to delete, 
change or rename data files. There may be some application functionality to which a user 
does not have access. 
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The Role of the Administrator 

There is a two-fold role for the Administrator, which could in fact be two different people: 

• As Administrator for the Windows operating system (PC Administrator) 

• As Administrator for the Spectrum ES Software systems (Software Administrator) as 
shown in a table on page 86. 

W indows Administrator 

Someone trained as an Windows Administrator should control the PC that the Spectrum ES 
Software is installed on. They will be responsible for all Windows User/Password settings, 
Windows Auditing and NTFS file security. 

NOTE: End users, that is people using the software and instruments to collect data should 
run as Windows Users, never as Windows Administrators.  

The Windows Administrator should: 

• Set up Password and User name policies according to the company’s internal security 
policy. Pre-installed Windows usernames are shown in Windows Login Security on  
page 32. 

• Ensure that Users only have access to folders and files that they need access to. This 
includes network drives. 

• Consider whether the floppy drive or CD Writer should be disabled by Windows for 
Windows Users, given that all data from using the instrument must be retained. 

• Setup the Start menu so that the users can only access applications that they need. 

• Make sure that Users are prevented from deleting or appending any files (by using the 
security features in NTFS) in the file locations where data is saved. 

• Setup file control as discussed in Protecting Saved Data Files using NTFS on page 45. 

• Use the Windows auditing features to track login attempts, attempts to delete files. 

• Consider whether to set up a password protected screen saver to guard against 
unauthorized use of the system when unattended. 
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• Ensure that appropriate backup procedures are in place for data files and the security 
and audit databases. This is covered extensively in Appendix III – Backup and Recovery 
on page 81. 

NOTE: Some of these tasks can be automated by running the Windows Configuration Script, 
as discussed on page 76. 

W indows Login Security 

The Windows configuration supplied with your system includes two main Windows users: 
Administrators and Users. 

The Windows administrator account gives the administrator full access to the whole system, 
including the ability to Delete and Rename files, run any application, and change user and 
file/folder permissions. Clearly the administrator has great power, and so the person acting in 
this role should be suitably trained and qualified in Windows to take on this role. It is 
recommended that this person is not the same person who will be using the instrument on a 
day to day basis. 

The Windows user account provides a minimum set of permissions for someone to run the 
software and use the instrument. 

NOTE: It is recommended that the Windows Administrator sets up different groups and 
accounts according to the company requirements, following standard procedures, and 
deletes the standard accounts, or as a minimum, changes the passwords. If the 
default accounts are left unchanged, it could be a way for an unauthorized person to 
access the system. 

NOTE: Being logged on as a Windows Administrator gives full read/write permissions to the 
system, so Spectrum ES software should only be used to collect or process data when 
logged on as a Windows User, to avoid negating the 21 CFR Part 11 compliance. 
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W indows Auditing 

Within Windows and the NTFS file system it is possible to audit activity within directories or 
files themselves. This allows the Windows Administrator to keep a log of which user is 
accessing what data and whether this is failing or succeeding. 

For example, it is possible to set auditing of the directory where the data files are stored, and 
monitor attempts to delete files. 

NOTE: Audit logs can get very large if not carefully set up and managed, and that they can 
fill up disk space very quickly. 

Login auditing is also available within Windows, to monitor access to the system; for example 
looking for failed attempts at login. 

Spectrum ES Software Administrator 

There is also a need to have a Software Administrator to set up and maintain the security of 
the Spectrum ES Software.  

The Software Administrator is required to: 

• Define how users login to Spectrum ES, see Spectrum ES Login Types on page 37. 

• Administer the database of users, including adding new users and setting their 
permissions and passwords, see Spectrum ES Login Types on page 37. 

• Track the Login History, see Spectrum ES Login Security on page 42. 

• Track the Audit Trails, see Spectrum Administrator’s Audit Trail page 44. 

NOTE: The Software Administrator does not need to be a Windows Administrator, they can 
be a Windows User if required. 

 

NOTE: It is important to remember that the software administrator assigned to administer 
the Spectrum ES software will automatically have the ability to administer any other 
PerkinElmer application that has been installed which uses the PerkinElmer Security 
Manager. In the same manner, user names are global, that is, a user name assigned 
to one PerkinElmer application is also made available to all other PerkinElmer 
applications. Although Administrators and Users are global in nature, groups and 
instruments assigned to the software are application specific. 
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The Admin Util ity 

 

The above screenshot shows the main screen of the Admin Utility. 

To access the Admin Utility: 

1. Select Admin from the Spectrum ES group under PerkinElmer Applications in the 
Programs section of the Start menu. 

2. Login as administrator, with the password of administrator. 
After you login, the Administration Utility will start. 

NOTE: Passwords are case sensitive. 

NOTE: We recommend that a backup administrator is created as soon as possible after 
installation. To create an administrator refer to Creating Admin Utility Administrators 
on page 52. 
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What are the Default Users? 

The following groups and users are pre-defined when Spectrum ES is installed: 
 

Username Password Member of 
Group 

Comments 

For access to Administration Utility (Admin.exe): 

Administrator administrator Spectrum 
Administrators 

Spectrum Administrator 
who creates and 
maintains Groups and 
Users, setting access 
permissions to 
instruments, controlling 
Audit Trails, and using the 
Legacy File Converter 

For Spectrum One instrument: 

Super SP1 Super SP1 Super_SP1_grp Supervisor with advanced 
access to instrument, 
most Spectrum ES 
functionality 

User SP1 User SP1 User_SP1_grp End user with minimal 
access to instrument, 
some restrictions to 
Spectrum ES software 

For Spectrum NTS instrument: 

Super NTS Super NTS Super_NTS_grp Supervisor with advanced 
access to instrument, 
most Spectrum ES 
functionality 

User NTS User NTS User_NTS_grp End user with minimal 
access to instrument, 
some restrictions to 
Spectrum ES software 
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Username Password Member of  
Group 

Comments 

For Spectrum GX instrument 

Advanced GX Advanced GX Advanced_GX_grp Supervisor with 
advanced access to 
instrument, including  
Spectrum ES 
functionality. Access 
to all GX menus 
including the Setup 
Instrument 
Adjustments dialog. 

Standard GX Standard GX Standard_GX_grp Super user having 
standard access to the 
instrument. Access to 
all GX menus but not 
the Setup Instrument 
Adjustments dialog. 

Routine GX Routine GX Routine_GX_grp End user with minimal 
routine access to 
instrument, some 
restrictions to 
Spectrum ES software. 
No access to the 
Instrument or Setup 
menus 

NOTE: Passwords are case sensitive while User names are not. 
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Spectrum ES Login Types 

There are two ways to login to Spectrum ES. The Software Administrator is responsible for 
determining which type is used. 

• PerkinElmer Login 
This involves creating a User Name and Password for each Spectrum user, over and 
above the Windows login on the PC. 

• Windows Login 
This allows Windows users to login to Spectrum using their Windows User Name and 
Password instead of having a separate Spectrum User Name and Password. 

Setting up PerkinElmer Login 

When Spectrum ES is installed, it is set to PerkinElmer Login by default. If you wish to 
continue using this login type, you do not need to change any settings. 

Setting up Windows Login 

During the installation of Spectrum ES, a PKIUsers group is created on the local PC. All users 
who wish to log in to Spectrum using their Windows User Name and Password must first be 
added to the PKIUsers group by the Windows Administrator. 

When Spectrum ES is installed and run on a local PC, the Windows Administrator should add 
users to the PKIUsers group on that PC. When Spectrum ES will be used across a network, 
the Windows Administrator should create a network group on an accessible domain and then 
add users to that group. 
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To add users to the PKIUsers group on a local PC: 

1. Install Spectrum ES. 

2. From the Start menu, select Settings and then select Control Panel. 

3. Double-click on Administrative Tools. 

4. Double-click on Computer Management. 
The Computer Management dialog is displayed. 

5. Double-click on Local Users and Groups. 

6. Double-click on the Groups folder to see the list of available Groups on the PC. 

7. Double-click on PKIUsers. 
The PKIUsers Properties dialog is displayed. The Members list already contains 
Everyone. This group has been created for folder access only, not as a Windows user 
group as it contains no user members. 

8. To add a user member to the Group, click Add. 
The Select Users, Computers, or Groups dialog is displayed. 

9. To select a user from a different location (domain), click Locations and then select the 
required location for the user you wish to add. 

10. To add a user to the group, enter the name of the user in the Enter the object name 
to select field and then click Check Names. 
Clicking Check Names will validate the name on the specified domain. 

11. Click OK. 
The Select Users, Computers, or Groups dialog is closed and the user is added as a 
member to the PKIUsers Properties dialog. 

To add more users, repeat steps 8 to 11. 

NOTE:  It is possible to add a user more than once if they are on more than one domain as 
each Location together with the User name and Password will be unique. 
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All users added to the PKIUsers Group on the local PC, or added to a network users group 
will be able to log in to Spectrum ES once the Software Administrator has defined the Login 
Type as Windows Login. 

To define the Login Type as Windows Login: 

1. Start the Admin Utility. 
From the Start menu select PerkinElmer Applications, then select Spectrum ES and 
then select Admin. 

2. Log in as an Administrator. 
The default User name is Administrator and the Password is administrator. 

3. From the Utilities menu select Administrator Setup. 
The Users, Password Control, Login History, Audit Trail and Summary dialog is 
displayed. 

4. Select the Password Control tab. 

5. From the Login Type drop-down list select Windows Login. 
All the other information previously displayed on the tab is removed as the password 
controls are now from Windows rather than Spectrum ES. 
The Load Windows Users dialog is displayed. 

6. Select the domain and specify the group of Windows users that you wish to add to the 
list of Spectrum users. 
The default selection is the PKIUsers group on the local PC.  

7. Click OK. 
The Windows users will be loaded and you may be prompted to select a new 
Administrator. 

NOTE: If users are subsequently added to the PKIUsers group, the Software Administrator 
must click Update users on the User tab of the Users, Password Control, Login 
History, Audit Trail and Summary dialog to add the new Windows users to the list of 
Spectrum users. 

 

NOTE: The Login Type (Windows Login or PerkinElmer Login) applies to all users. It is not 
possible to have some users that log in using their Windows Login while others use a 
separate Spectrum login. 
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Creating New  Users and Assigning Users to Groups 

NOTE: Creating new users is not applicable when Windows Login has been defined as the 
Login Type on the Password Control tab of the Users, Password Control, Login 
History, Audit Trail and Summary dialog. In this case new users should be added 
using Windows User Management. However, new users must be assigned to groups 
to use the Spectrum software. 

Each person using Spectrum ES must be setup as a user from the Admin Utility by the 
Software Administrator. New users are then assigned to one or more Spectrum ES groups. 

1. Start the Spectrum ES Admin Utility. 
See The Admin Utility on page 34. 
Log in as an Administrator. The default User Name is Administrator and the Password is 
administrator. 

2. Click the Access Administration bar in the left pane. 

3. Click  Click here to retrieve access information to load the access information. 

4. Click the + icon on the Instrument that you wish to add the user to. 
This expands the view and shows which Groups and Users are allocated to this 
Instrument. 

5. Click . 
The Users, Password Control, Login History, Audit Trail and Summary dialog is 
displayed. 

6. Select the User tab and then click New. 
The New User dialog is displayed. 

7. Enter the User name, Full name, Password, and repeat the Password in the 
Confirm password entry field. 
The Password is case sensitive. It can consist of letters, numbers and single spaces 
only. 
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8. Select Enabled if you wish the user to be able to login or Disabled if you do not wish 
them to be able to login at the current time. 
In Spectrum ES, User must change password at next login is always selected when a 
new user is created. This is to ensure that the first time the user logs in they will be 
forced to change their password. This means that the password is known only to the 
user and not the administrator. 

9. Click OK. 
The Name drop-down list is updated with the new user. 

10. To give the user access to an instrument, select the Group from the list of Available 
groups for user and then click Add. 
The Group is added to the User is a member of list. 

11. Click OK to close the Users, Password Control, Login History, Audit Trail and Summary 
dialog and apply the changes. 

NOTE: When using the Windows Login, at least one user must be assigned Administrator 
rights. If not, it will not be possible to exit the software. If a user is not added to at 
least one group, an error message will be displayed when they try to log in informing 
them that they do not have access to the application. 

The Admin Utility enables the Software Administrator to set the options to be used for each 
group, including the ability to: 

• Disable individual menu commands 

• Define the icons available on the toolbar and toolbox 

• Set the default directories and other configuration settings 

• Set the level of instrument access 

Each instrument has a series of groups associated with it. Each group is able to perform a 
series of operations such as setting up an instrument and performing a scan. Users are 
assigned to a group per instrument. 

NOTE: Users may be assigned to more than group, if the groups are associated with 
different instruments. Users may not however be assigned to multiple groups, where 
the groups in question are assigned to the same instrument. 

Further information can be found in the HTML Help file for that application, viewed by 
selecting Contents and Index from the Help menu. 
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Spectrum ES Group Audit Trail 

This Audit Trail records all changes to the Spectrum ES Software on the PC and the 
configuration of the user groups. 

1. Select Admin from the Spectrum ES group under PerkinElmer Applications in the 
Program Files section of the Start menu. 
After you login, the Administration Utility will start.  

2. Select Spectrum ES Audit Trail from the view bar on the left side of the dialog. 

3. Click Active Database. 
The current database is displayed, it shows: 

• changes to the software installed on the PC 

• changes to the configuration of user groups 

 

Spectrum ES Login Security 

The level of access available to users of Spectrum ES software depends on the permissions 
set by the Software Administrator, see Creating New Users and Assigning Users to Groups on 
page 40. 

Part of the planning process for establishing Spectrum ES within a 21 CFR Part 11 compliant 
environment must be to plan the permissions allocated to the users and groups to best fit the 
company’s working procedures. 

 



Administration of Spectrum ES . 43 

Spectrum ES Login History 

The Login History can only be viewed by users who are members of a group that has 
permission to perform administration tasks. 

1. Select Admin from the Spectrum ES group under PerkinElmer Applications in the 
Program Files section of the Start menu. 
After you login, the Administration Tools will start.  

2. Select Administrator Setup from the Utilities menu.  
The dialog is displayed. 

3. Select the Login History tab. 
The login history is displayed. This details every login attempt, since the history was last 
cleared, by: 

• Full Name 

• User Name 

• Computer 

• Status - OK indicates that the user logged in with the correct password,  
Failed indicates that a login was attempted with an incorrect password. 

• Logged In - date and time. 

• Logged Out - date and time. 

NOTE: If a non-existent User Name is entered during login a failed login attempt is 
recorded. Not Found is entered in the Full Name field of the Login History, and the 
incorrectly entered User Name is also recorded. 

 

NOTE: The only limit to the size of the Login History is disk space, but we recommend that 
you review and archive audit trails at regular intervals. 

The Login History can be printed and exported as a Comma Separated Values (.csv) file. 
After exporting, the Login History can be cleared. We recommend that the exported Login 
History is backed up and kept in a secure location. 
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Spectrum Administrator’s Audit Trail 

This Audit Trail records all changes to security settings in compliance with 21 CFR Part 11. All 
changes to users, groups and password settings are recorded. 

1. Select Admin from the Spectrum ES group under PerkinElmer Applications in the 
Program Files section of the Start menu. 
After you login, the Administration Utility will start. 

2. Select Administrator Setup from the Utilities menu.  
The dialog is displayed. 

3. Select the Audit Trail tab. 
The audit trail is displayed. 

 
For each change recorded, the following information is given in the Audit Trail:   

• Function - the item that was changed, for example, Add New User. 

• Previous Value - the state of the item before it was changed. 

• Current Value - the new state. 

• Full Name - the full name of the user who made the change. 

• User Name - the login user name of the user who made the change. 

• Computer – the name of the computer from which the change was made. 

• Date Modified - the date and time of the change. 

The Audit Trail can be printed and exported as a .csv file. After exporting, the Audit Trail can 
be cleared. We recommend that the exported Audit Trail is backed up and kept in a secure 
location. 
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Protecting Saved Data Files using NTFS 

Spectrum ES saves most of its data in files, for example spectra are saved as .sp files. The 
NTFS file system allows the Windows Administrator to set security permissions for every file 
and subdirectory as required, and if accidental or malicious deletion of data is to be avoided, 
then setting up the right permissions on these data files is an important consideration within 
a 21 CFR Part 11 compliant environment. 

Users clearly need the ability to write data files to the NTFS file system, but once written, 
they typically shouldn’t need to change or delete them. Before security settings are discussed 
the following must be undertaken if working with Windows XP. This is to ensure that the 
Security tab within the file/folder Properties dialog is available when applying the security 
settings. 

NOTE: This section details how protection of the relevant files can be done manually. Should 
you wish to apply the protection automatically, then you can run the lockdown script 
as detailed in Appendix II – Windows Configuration Script on page 76.   

NOTE: As part of the installation process of the software the Full Control permission is 
applied to ‘Everyone’ for the \windows\temp directory. This is essential for the 
software to operate correctly. 

Procedure for View ing the Security Tab 

NOTE: The procedure for making the Security tab visible only applies to Windows XP and 
may be ignored if you are using Windows 2000. If the Security tab is visible already 
when accessing the Properties dialog for files and folders within Windows XP, then 
this procedure may be ignored as well. 

1. Open Windows Explorer and select the C: drive or the drive where Spectrum ES has 
been installed to. 

NOTE: If you do not want to apply the change to all folders within the drive, then this 
procedure must be repeated for each relevant folder where this needs to be applied 
and step 6 should be ignored in this case. 

2. From the Tools menu select Folder Options. 
The Folder Options dialog opens. 

3. Select the View tab. 
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4. Within Advanced settings scroll to the very bottom. 

5. Deselect Use simple file sharing (Recommended). 

6. Click Apply to All Folders. 

7. Click OK. 
The Folder Options dialog closes. 

Applying Security Settings 

The following default directories store important data and it is important to set the security 
settings as illustrated in the figures for the sub-directory and folders as follows.  

NOTE: x in each case refers to the drive Spectrum ES is installed to. 

The directories x:\pel_data\ and x:\pel_apps\ needs the Modify permission set for 
Everyone. 

 
 
The two figures on the next page (for the files and folders/subfolders respectively) show the 
NTFS security settings (that is Write Once, Read) for the following folders: 
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• x:\pel_data\reports 

• x:\pel_data\spectra 

• x:\pel_data\igram 

• x:\pel_data\chrom 

• x:\pel_data\pktables 
 

1. Select the all the folders mentioned above. 

2. Right-click the mouse and select Properties. 

3. Select the Security tab. 

4. Highlight Everyone and click Advanced. 

5. Apply the settings as illustrated below. 
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The following files need the Modify permission set for Everyone as shown in the figures 
below: 

• x:\windows\pel_inst.ini 

• x:\windows\pel_apps.ini 

• x:\windows\pel_apps.bci 

• x:\windows\pe_sopb.ini 
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NOTE: If you store your data files elsewhere, then the equivalent directories to the above 
should be considered for protection.    
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Spectrum ES Administration Made Simple 

Spectrum ES is shipped with default users and groups setup. These are described on  
page 35. 

NOTE: This section summarizes some of the administration activities within the Admin Utility 
and therefore does not provide full details of every step involved in performing these 
activities. Refer to the Admin Utility Help which can be accessed from the Help menu 
of the main screen of the Admin Utility for more detailed information. 

NOTE: To open the Admin Utility see page 34. 

Define Login Type 

There are two ways to login to Spectrum ES. These are PerkinElmer Login and Windows 
Login. For more information see Spectrum ES Login Types on page 37. 

Create a New  User and Assign to a Group 

If you want to add a new user and give them access to an instrument then it is easiest if you 
make the new user a member of one of the preinstalled groups. See Creating New Users and 
Assigning Users to Groups on page 40.  

Your new user is now able to access the instrument, and any other instrument which has the 
same group allocated to it. 

To Setup New  Groups 

1. Click on the Group Configuration bar. 
A list of existing groups will be displayed. 

2. Select New from the File menu. 
This will display the New Group dialog which allows you to create a new group based 
on an existing group.  
It is recommended that you base a new group on an existing one, rather than create a 
completely new one. 

3. Enter a new name – use the convention of ‘_grp’ in New group name. 

4. Select an existing group from the Based on drop-down list. 
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5. Click OK. 
The New Group dialog closes and the new group is added to the Group Configuration 
list. 

6. Click on the newly created group name and make the desired changes to Menu’s, 
Toolbar, Toolbox and Configuration options. 

7. Select Save from the File menu. 
The new group is configuration is saved. 

Assigning the Group to an Instrument 

1. Click on the Access Administration bar. 

2. Select Add Group from Tools menu. 

3. Click on the group created in To Setup New Groups on page 50 which is available in the 
left pane. 
The group is highlighted as a result. 

4. Select the instrument(s) in the right pane you wish the group to have access to.  
Press the Ctrl key when selecting with the mouse to select multiple instruments.   

5. Click OK. 
The Group has now been assigned to the selected instrument(s). 

Checking the Groups to Which the User has been Assigned 
to 

1. While still in Access Administration expand all instrument trees by clicking on + to the 
left of the all instrument names. 

2. Click on the instrument(s) that has the newly created group assigned to it.  
This will show all users that can access this instrument in the Users pane.  

3. In the Users pane, click on the newly created User. 
You will see any group that the User belongs to is show in red in the Access 
Administration pane. 
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Administrators 

Creating Admin Utility Administrators 

1. Select Administrator Setup from the Utilities menu. 
The Users, Password Control, Login History, Audit Trail and Summary dialog is 
displayed. 

2. Either select a User Name from the drop-down list.  

OR 
 
Create a new user by clicking New. 

3. Select Administrators from the Available groups for user left hand panel. 

NOTE: Administrators cannot be members of any other group and they cannot access 
Spectrum ES. 

4. Click Add. 

5. Click OK. 
The Users, Password Control, Login History, Audit Trail and Summary dialog closes. 

The User is now an administrator of the Admin Utility.  

Membership Of More Than One Group 

• Administrators cannot be members of any other group at the same time as being a 
member of the administrator group. 

• Users can be members of more than one group, but the groups must be associated with 
different instruments.  

Other Administration Functions 

This overview attempts to provide some of the key concepts on administering Spectrum ES. 
For further details on these concepts including other relevant information, such as the 
password control tab, account lock out and what to do if a user is locked out, refer to the 
Help. The Help can be accessed via the Help menu within the Spectrum ES software. 

 



 

An Overview  of Spectrum ES 
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Starting Spectrum ES 

Using PerkinElmer Login 

1. To start the Spectrum ES application, select Spectrum from the Spectrum ES group 
under PerkinElmer Applications from the Programs section of the Start menu. 
The Spectrum Login dialog is displayed. 

 

2. Select the Instrument to be controlled and then click OK. 
The PerkinElmer login dialog is displayed. 

 

3. Enter your User name and Password as set up by the Software Administrator (see 
What are the Default Users? on page 35). 

4. Click OK. 
The software will start. 
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Using Windows Login 

1. To start the Spectrum ES application, select Spectrum from the Spectrum ES group 
under PerkinElmer Applications from the Programs section of the Start menu. 
The Spectrum Login dialog is displayed. 

 

2. Select the Instrument to be controlled and then click OK. 
The Windows Login dialog is displayed. 

 

3. Enter your User name and Password. 
If the Log on to field is not displayed, click Options>> to show the field. 

4. Select the required Domain from the Log in to drop-down list. 
By default, the last Domain that was logged on to is displayed. 

NOTE: If all users are on the same Domain, there is no need to show the Log on to field as 
the correct Domain will be listed. It may avoid confusion to users if this field is 
hidden. If the Log on to field is shown, click Options<< to hide it. 

5. Click OK. 
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Using Spectrum 

Spectrum is the main PerkinElmer software package for collecting, viewing and processing IR 
and NIR spectra. 

 

The View menu contains commands that enable you to change the way you view the 
spectrum, while the Process menu contains commands to manipulate the data including the 
ability to extract qualitative and quantitative information from the spectrum. 

Spectrum is a very powerful software package, to familiarize yourself with its abilities we 
suggest you work through the on-screen tutorials by choosing Learning Spectrum on the 
Help menu. 
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IR Assistant 

An alternative way to use Spectrum is the IR Assistant. This is a 'wizard' system that provides 
access to the full power of Spectrum, but uses default options where possible to avoid the 
complexity of the full Spectrum interface. 

 

The IR Assistant has a unique help system, which displays information just when you need it. 
When you hold the mouse pointer over a control on the software, help for that control 
appears, to guide you in its function. 

 

When you have built your task you can save it so that it can be used again. 
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This then becomes a simple way to automate tasks that are routinely performed. 

For details how to run the IR Assistant on a restricted system see IR Assistant / Quant 
Import on page 79. 

Instrument Control 

Spectrum also contains the software required to control your instrument. Further information 
about controlling your instrument or processing the spectra and data from samples is given in 
the on-screen help available in the software. 
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Report Builder 

Report Builder is an integral part of Spectrum that helps you turn your data into a single 
page report. 

 
 

The report can contain System, Status and Instrument information related to the spectral 
data as well as text you enter yourself, and templates can be set up to always lay out the 
information in the same way. 
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HTML Help 

HTML Help uses a window split into three sections (Tripane Window) to display help topics: 

 

• Toolbar - across the top of the window is a series of tools that help you navigate, print 
and customize the help. 

• Navigation Pane - on the left of the window are the Contents, Index, Search, and 
Favorites tabs, which enable you to find your way around the help system. 

• Main Window - the right side of the window is where the individual help topics are 
displayed. 
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How  Do I  Navigate Around? 

There are lots of ways to navigate around an HTML Help system: 

Contents 

If you select Contents and Index from the Help menu, the tripane window is displayed 
showing the opening page of the help system. Using the Contents tab in the navigation 
pane, clicking on a book icon ( ) will open ( ) the book and display the pages ( ) and 
sub-books inside it. Clicking on a book or a page also displays that help topic. It should be 
noted that unlike previous versions of help, books now have their own topics that in general 
give an overview of the topics in the book and/or a different way to navigate to the topic you 
require. 
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Index 

Index enables you to look up topics that have been linked to a particular keyword by the 
help author. 

 

Search 

Search enables you to search the whole of the help for a word, phrase, or set of words.  

This help file can use Boolean, wildcard and nested expressions to narrow down the search. 
For instance, the AND, OR, NOT, and NEAR operators enable you to precisely define your 
search by creating a relationship between search terms. The following table shows how you 
can use each of these operators. 

NOTE: If no operator is specified, AND is used. For example, the query “spacing border 
printing” is equivalent to “spacing AND border AND printing”. 
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To search for Use For 
example 

Will give 

More than one term 
in the same topic. 

AND baseline AND 
correction 

Topics that contain both 
the words “baseline” and 
“correction”. 

Either term in a 
topic. 

OR spectrum OR 
spectra 

Topics that contain either 
the word “spectrum” or 
the word “spectra” or 
both. 

The first term 
without the second 
term. 

NOT peak NOT 
table 

Topics that contain the 
word “peak” but not the 
word “table”. 

Both terms in a topic, 
close together. 

NEAR third NEAR 
derivative 

Topics that contain the 
word “third” within eight 
words of the word 
“derivative”. 

When the topic is selected, the specified words are highlighted. 
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Favorites 

Favorites enables you to pick out topics that you want to be able to get to quickly. 

 

 To add a topic to your favorites list, while displaying the required topic, switch to the 
Favorites tab and then click Add. 

The Back button 

At any time during the use of a help file you can click on the  button to return to the 
previous page of the help. 

Context sensitive help 

You can also call the help file by clicking Help on a dialog. This will start the same help file 
but will immediately take you to the page of information most relevant to the help button you 
clicked. 
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Printing HTML Help 

You can also print out help topics. 

1. Click . 
The Print Topics dialog is displayed. 

 

2. If you are currently viewing a book level topic you can select whether to print just the 
selected topic or to print all the topics in that book. 

3. Click OK. 
The topic(s) are printed to the default printer. 
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Other Considerations 

Shut Down of Windows w ith Spectrum ES Still Running 

When you want to shut down Windows first make sure that you have exited from Spectrum 
ES (ensuring all data is saved, if necessary). 

We do not recommend that Windows is shut down before exiting from Spectrum ES as this 
can cause problems with the shut down procedure, and may require the use of Task Manager 
to ensure a clean Windows shutdown. 

Removing Accessories During a Scan 

Spectrum ES tries to cater for most unexpected occurrences, but if an accessory is removed 
from the instrument during a scan/background scan then this can cause an error. This is not 
recommended practice anyway, as the act of removing an accessory in itself could invalidate 
the data. 

 
 

 

 

 

 



 

Appendices
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Appendix  I  – Configuring TCP/ IP Communication 

TCP/IP is the communications protocol used by the Spectrum One and the Spectrum One 
NTS to connect to the PC. If TCP/IP communication is not configured on your PC you will 
need to do so before you can establish communications between the PC and your instrument. 

NOTE: This appendix is not applicable to the Spectrum GX instrument as TCP/IP is not 
required. 

 

NOTE: You must be logged on at Windows Administrator level to configure TCP/IP. 
 

NOTE: The dialogs shown below are typical examples of a straightforward installation, they 
should not be taken as exact representations of what you will see on your PC. If you 
need assistance, please talk to your network administrator. 

1. From the Start Menu, select Settings and then Control Panel. 
The Control Panel dialog is displayed. 

2. Click  for Windows 2000. 

Or   

Click  for Windows XP. 
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For Windows 2000 the Network and Dial-Up Connections dialog is displayed. 

 
 
While for Windows XP the Network Connections dialog is displayed. 
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3. Right click on Local Area Connection and then select Properties. 
The Local Area Connection Properties dialog is displayed. 

 

4. If Internet Protocol TCP/IP is already listed on the dialog, go to step 8. 

5. If Internet Protocol (TCP/IP) is not listed on the dialog, click Install. 
The Select Network Component Type dialog is displayed. 

NOTE: The absence of Internet Protocol (TCP/IP) is discussed using Windows 2000 as an 
example. In the event that Internet Protocol (TCP/IP) is absent under Windows XP, 
then the process for installing this is the same as for Windows 2000. 
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6. Select Protocol and then click Add. 
The Select Network Protocol dialog is displayed. 

 

7. Select Internet TCP/IP Protocol and click OK. 
The Network dialog is re-displayed and TCP/IP Protocol has been added to the list.  

 

8. Select TCP/IP Protocol and click Properties. 
The Internet Protocol TCP/IP Properties dialog is displayed. 
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9. Select Use the following IP address and then type in the IP Address and Subnet mask 
for the PC. 
If your PC is on a network, you will need to consult your network administrator to get 
an IP address. If your PC is not on a network, you should enter the numbers shown on 
the next page. 

NOTE: If you connect the PC to an Internet enabled network you must make sure that the 
IP Address and Subnet mask you use are ‘safe’. 

 

NOTE: If you use the settings shown overleaf you must not connect the PC to an Internet 
enabled network. 
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10. Click OK.   
You will be prompted to reboot the PC. 

NOTE: TCP/IP communications are now configured, but you will need to reboot your PC 
before this change takes effect. 

 



74 . Spectrum ES Administrator’s Guide 

Using the SetIP Utility 

The SetIP utility may be used to change the TCP/IP address of a Spectrum One or Spectrum 
One NTS instrument, especially if the computer is connected to a network. To access SetIP 
and change the TCP/IP address follow the procedure as outlined below. 

NOTE: Ensure that the Spectrum ES software is not running while using this utility as SetIP 
may not run correctly. 

1. Open Windows Explorer and double-click SetIP.exe which is found in the 
\pel_apps\install\spectrum_one directory. 
The SetIP program starts. 

 
 
The address shown above is only an example and may not reflect the TCP/IP address 
that you may be using.
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2. Enter the new address in TCP/IP address and Subnet Mask and then click Update. 
Further on-screen instructions below New Address will be displayed, which serves as 
confirmation that the new TCP/IP address has been conditionally accepted. If the new 
TCP/IP address is not accepted then an error dialog will be presented. 

 

3. Click Exit to close the utility and then switch the instrument off and on again in line with 
the on screen message. 
The TCP/IP address is sucessfully changed. 
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Appendix  II  – Windows Configuration Script 

For 21 CFR Part 11 systems further security is recommended to make sure, for example, that 
data files cannot be deleted or tampered with. The lockdown script will set the essential 
security permissions automatically, but the Windows administrator should review what has 
been set and consider whether further changes are required. 

Running the Lockdown Script 

To run the lockdown script:- 

1. Insert the IR Spectroscopy ES CD in the drive. 

2. Double-click on the \NT Security\ directory. 

3. Double-click on Lockdown.vbe to run the script. 
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What the Lockdown Script Does 

The Lockdown Script sets directory and file permissions, sets up default windows groups and 
accounts and “locks down” the desktop. 

Directory and File Permissions 
 
The Lockdown script sets the following restricted permissions on these directories and files: 

NOTE: x in each case refers to the drive Spectrum ES is installed to. 
 

Directory Windows 
Administrator 

‘Everyone’ 

x:\pel_apps\…… Full Control Modify 

x:\pel_data\…… Full Control Modify 

x:\pel_data\reports\ Full Control Write once, Read 

x:\pel_data\docs\ Full Control Write once, Read 

x:\pel_data\spectra\ Full Control Write once, Read 

x:\pel_data\igram\ Full Control Write once, Read 

x:\pel_data\chrom\ Full Control Write once, Read 

x:\pel_data\pktables\ Full Control Write once, Read 

 

x:\windows\temp Full Control Full Control 
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Files Windows 
Administrator 

‘Everyone’ 

x:\windows\pel_inst.ini Full Control Modify 

x:\windows\pel_apps.* Full Control Modify 

x:\windows\pe_sopb.ini Full Control Modify 

In addition, the lockdown configures the following: 

• Restricts permission to Microsoft Management Console (MMC). 
MMC is a feature of Windows 2000 and XP that allows a user to configure security 
policies for their PC. If a user were to run this, they could potentially undo parts of the 
lockdown script. Refer to Management Console and Active Directory on page 80 for 
more details. 

• Lifts permission to Internet Explorer. 

• Disables Windows XP Guest account. 

• Sets the PerkinElmer logo as the backdrop for all new users. 

• Configures the restricted start menu. 
This uses registry policy settings to disable items including Control Panel, My Computer, 
Network Neighbourhood. 

NOTE: Applications installed on the PC after the Lockdown Script has been run do not 
appear on the Start menu. The Windows Administrator must copy the application 
shortcuts to the Start menu (or desktop) as required.   

• Creates the SpectrumES group and the SpectrumES User 

• Creates the PEService user. 

Write Once directories allow files to be created but they cannot be deleted, edited, renamed 
or moved. 
 
If operating in a 21 CFR Part 11 environment it is highly recommended that permissions of 
this type are used to protect key data, such as spectra files and reports. 
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Default W indows groups and accounts 

The script then sets up the following default accounts: 

SpectrumES User     <password:  SpectrumES User> 
which is an ordinary Windows User account. 

PEService          <password:   peservice>  
and is for use by PerkinElmer service engineers. 
 
The lockdown script sets these permissions for the Windows group called Everyone. This is 
the windows default group that has all users as members. Additionally the minimum 
Windows password length is set to six characters. 

IR Assistant /  Quant Import 
 
In addition to setting up default groups and accounts the script also sets the  
correct Registry permissions for IR assistant and Quant Import to run. 

However, if you wish to set up IR Assistant and Quant Import to run on a restricted system 
without running the lockdown script, then do the following: 

1. Log onto Windows as an Administrator. 

2. Click Run from the Start menu. 

3. Enter the following text precisely (with the quotations marks as written) cmd /c ""d:\nt 
security\regini" "d:\nt security\irasst.txt"" 

NOTE: The letter d refers to the letter assigned to the CD-ROM drive. It should be replaced 
with the appropriate letter for your CD-ROM drive. 

4. Click OK. 

5. Enter cmd /c ""d:\nt security\regini" "d:\nt security\Quant_import.txt"" 

6. Click OK. 
IR Assistant and Quant Import will now run on a restricted system. 

Background Wallpaper 
 
The script sets the background wallpaper. 
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Locking down the desktop 
 
Examples of the settings are: 

• No Control Panel available 

• No Find 

• No Network Neighborhood 

• No Right mouse button click menus 

NOTE: The full list of settings made can be found in \windows\system32\policy.txt. These 
settings can be edited if required before running the lockdown script. The settings will 
apply to ordinary Windows Users (for example, SpectrumES User), not to the existing 
Windows administrator. 

Management Console and Active Directory 

The management console is a Windows 2000/XP feature that allows the Windows 
administrator the facility to set many features in Windows, in particular security features. The 
list of choices is huge but all the ones set by the Lockdown scripts can be set or unset via the 
Management Console (and its Snap-ins).    

The Windows administrator may wish to review the options available from the console in light 
of the 21 CFR Part 11 requirements. 

Active Directory is a feature in Windows that manages computer settings from a central place 
and allows security and other settings to be centrally managed by an Active Directory server 
usually on a Windows domain server. 

If the target computer for PerkinElmer ES software is on an Active Directory network, then 
this may be a preferable way of managing computer/windows settings than by using the 
lockdown script. 

 



Appendices . 81 

Appendix  II I  – Backup and Recovery 

Backing up and Recovering Databases and Files 

It is essential that backups are regularly made of key files and databases in order to secure 
the data in case of computer failure or accidental loss or damage. 

The following files/directories (including subdirectories) must be backed up regularly: 

The following directories (including subdirectories) must be backed up regularly:- 

C:\Pel_data\ 

C:\Documents and Settings\All Users\Application Data\PerkinElmer\SpectrumES\Audit 
Trail\v5\ 

The following files must be backed up regularly:- 

C:\Documents and Settings\All Users\Application Data\PerkinElmer\Security 
System\Users.mdb 

C:\Documents and Settings\All Users\Application Data\PerkinElmer\Security 
System\Backup\Users.bak  

C:\Windows\Pel_inst.ini 

C:\Windows\Pel_apps.ini 

C:\Windows\Pel_apps.bci 

C:\Windows\pe_sopb.ini 
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Recovering from Checksum Failures 

Spectrum ES uses a variety of security techniques to ensure that files cannot be tampered 
with either accidentally or deliberately – one of these is to use Checksums to ensure the data 
has not been tampered with. Under normal operation checksums are used in the application 
to validate the data security, however a checksum failure can occur after a number 
situations: 

• Hard disk failure 

• Power failure 

• Software crash, either the application or Windows or another application 

• Falsification of data 

The only remedy to an error message stating there is a checksum failure is to restore from a 
backup database. Checksum warnings will not occur during normal operation of Spectrum ES 
software. If they occur then the reasons for them should be investigated and the reasons 
understood, before simply recovering from the problem 

Security database 

The security system automatically backs up the Users.mdb database each time the software 
is closed, in a subdirectory called \Backup: 

C:\Documents and Settings\All Users\Application Data\PerkinElmer\Security 
System\Backup\Users.bak 

The Windows Administrator can restore from this database if the active database becomes 
corrupt and gives a checksum failure: 

1. Log on as Windows Administrator. 

2. Rename, Move or Delete Users.mdb 

3. Copy \backup\Users.bak as Users.mdb to replace the old one. 

Any changes to the users and groups made since the last time the software was closed will 
be lost. 
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Audit Trail database 

If the database (audit.mdb) fails for one of the above reasons, then replacing the corrupt 
database with a backup will usually cure any problem and allow the application to run again. 

Checksums and .bci & .ini files 

A security feature of Spectrum ES is that all PerkinElmer .ini files (e.g.  pel_apps.ini etc) 
which contain important system information can no longer be altered by directly changing the 
text in the files. Changes must not be attempted. (they will in fact be ignored). 

Although the .ini files still remain, they have been superseded by equivalent .bci files, which 
contain the same data and are encrypted and checksummed. 
Any attempt to change a .bci file will cause a checksum failure and Spectrum will issue an 
error message similar to “Checksum failure on …..bci file” or “Incorrect checksum value 
in file \pel_data\…..\*.bci”. Spectrum can no longer be used if that happens. 

 To recover from this, your administrator can run a utility: 
\pel_apps\install\spectrum_one\secinstall.exe 

This utility will restore the .bci file to a clean state and Spectrum will run again. The utility 
will ask you to log in and you must log in as Administrator. The .bci files will be checked to 
make sure they have valid checksums, and any that fail the check can be repaired. An record 
of this action is placed in the Audit trail database, which can be viewed from the Admin 
utility. 

Spectra files 

These are discreet files, usually stored in the c:\pel_data\spectra\ subdirectory with 
extensions .sp. 

These files are all checksummed and when files are loaded into Spectrum ES, their integrity 
is checked. 

If the checksum isn’t present or is wrong, then an error message is produced and the file will 
not load. 

It is possible to use the Legacy File converter to convert non-checksummed files – see 
Appendix IV. 
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Appendix  IV – Legacy File Converter 

21 CFR Part 11 technical compliance mandates very high levels of data integrity and security. 
To ensure that Spectrum ES only accesses and uses data acquired on a 21 CFR Part 11 
compliant system, a data security checksum has been added to the spectrum data file 
generated from an Enhanced Security software application. 

Spectra without this 21 CFR Part 11 checksum will not be read into the Enhanced Security 
software and cannot be processed. This feature stops data from older data systems from 
being automatically used in new compliant systems. 

To allow users access to their legacy data a Conversion Utility has been included as part of 
the Spectrum ES Administration tools. This utility allows the Administrator to add a data 
security checksum to all spectra in a directory of legacy spectra. 

NOTE: Use of the utility should be highly controlled and spectra that are converted should 
have full supporting GxP provenance as part of their audit trail. 

1. Select Admin from the Spectrum ES group of PerkinElmer Applications under 
Programs on the Start menu.  
The PerkinElmer Login is displayed. 

2. Enter your User name and Password and click OK. 
You must be a Software Administrator to be able to access the Administration Utility. 

3. Select Legacy File Converter from the Utilities menu. 
The Legacy File Converter is displayed. 

4. Click the appropriate Browse and on the file selectors displayed, select the Source 
Path and Destination Path for the directory containing the legacy data. 

NOTE: Ensure that the appropriate Write permissions for the destination directory are set 
before attempting to carry out the conversion. 

5. Click Next. 
The data is copied and a checksum is added to each file, then the new files are written 
to the destination directory, leaving the original data untouched. 

6. To view information about the conversion, click View Log. 
A log file is displayed. 
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Appendix  V – Quant Import Utility 

The Quant Import utility allows the administrator to include legacy Quant method(s) from 
PerkinElmer’s Quant C, Quant+ or Beer’s Law applications into Spectrum ES. The legacy data 
needs to be exported from the Quant PC using the Quant Export tools supplied with the 
Quant applications before it can be imported onto the Spectrum ES PC. Exported Quant 
methods are saved as a zipped file with a .qmz extension. 

NOTE: Use of the utility should be highly controlled and spectra that are processed should 
have full supporting GxP provenance as part of their audit trail. 

1. Select Admin from the Spectrum ES group of PerkinElmer Applications under 
Programs on the Start menu.  
The PerkinElmer Login is displayed. 

2. Enter your User name and Password and click OK. 
You must be a Software Administrator to be able to access the Administration Utility. 

3. Select Quant Import from the Utilities menu. 
The Quant Import dialog is displayed  

4. Click Add Zipfile To List and then navigate to the .qmz files to be added. 
File(s) chosen in this manner will be listed within Source Files. 

5. Click Next. 
The .qmz files are extracted. The Progress of the extraction process is indicated by Zip 
files extracted, Zip files remaining, Number Of Errors and status bar. A checksum is 
added to each file before being written to the destination directory. 

6. Once notification is given that extraction is complete, View Log should be clicked to 
ascertain which Quant methods were successfully extracted to the appropriate quant 
directory. 

NOTE: The destination directory for the extracted methods cannot be changed and it is 
important to ensure that the appropriate Write permissions are assigned before 
attempting this procedure. 

7. Close the Import Log and then click Exit to close the Quant Import dialog. 
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Appendix  VI – The Link Between Windows Logon 
Security, NTFS Permissions and Spectrum ES 
Security 

Since there are two security systems it is important for the system administrator to 
understand the link between the Windows logon system and the Spectrum ES system. Here 
is a table of the possible combinations and the implications and typical roles: 
 

Logon to 
Windows as 

Logon to 
Spectrum ES as 

Can do Can’t do Comment Typical role 

Administrator User  Anything to 
Windows 
including 
datafiles, adding 
new applications. 
Reviewing 
Windows audit 
trails, setting up 
user accounts etc 
Running 
Spectrum ES 

Change 
Spectrum ES 
settings. 
 
Access certain 
menus within 
Spectrum ES, 
depending on 
given 
permissions. 
 

Must be a 
suitably trained 
qualified person, 
but might be 
from the IT 
dept, who do 
not need to 
understand 
Spectrum ES. 

IT 
department 
staff 

User User   
 

Run Spectrum ES, 
typically taking 
scans and saving 
data. They can 
run other 
applications on 
the PC if allowed. 

Can’t change 
Windows or 
Spectrum ES 
settings. Can’t 
delete/change 
datafiles. 
 

Spectrum ES 
user who uses 
the system on a 
day-to-day basis 
within a 21 CFR 
part 11 
compliant 
environment.  

System 
technician, 
operator 
 
Scientist 

NOTE: It is not possible to log in to Spectrum ES as an Administrator. The Administrator can 
only log in to the Administration Utility. 
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